
 
 

 
 

 

      

 

 

 
USER GUIDE  

WoonZorgWelzijn Verkenner  
 

 
 

VERSION 5.88 
 
 
 



  User Guide WoonZorgWelzijn Verkenner 5.88 

 -  - 2 

 
 

 
 

 
 
 

 
 

 
 
 

 

 

User Guide WoonZorgWelzijn Verkenner 5.88  
 
 
Author: Martin van der Beek, Object Vision BV 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Amsterdam, September 2010 

 

 

 

 

 

  

Copyright © Object Vision BV 

 

 

Permission is granted to copy, distribute and/or modify this document under the 

terms of the GNU Free Documentation License, Version 1.1, published by the Free 

Software Foundation; with the Front-Cover Texts being User Guide GeoDmsGui 5.88. 

A copy of the license is included in the section entitled "GNU Free Documentation 

License" (http://www.gnu.org/licenses/fdl.html).  



  User Guide WoonZorgWelzijn Verkenner 5.88 

 -  - 3 

 

Table of Contents 
 

TABLE OF CONTENTS ......................................................................................................................... 3 

PART I GENERAL STRUCTURE ....................................................................................................... 5 

CHAPTER 1: INTRODUCTION ........................................................................................................ 5 

1.1 MAIN COMPONENTS OF THE WOONZORGWELZIJN VERKENNER ................................................... 5 
1.2 HOW TO READ THIS GUIDE ............................................................................................................... 6 
1.3 SYSTEM REQUIREMENTS ................................................................................................................... 6 

CHAPTER 2 DESKTOP COMPONENTS ........................................................................................ 7 

CHAPTER 2 DESKTOP COMPONENTS ........................................................................................ 7 

2.1 MAIN COMPONENTS OF THE APPLICATION ....................................................................................... 7 

CHAPTER 3: TREEVIEW ...................................................................................................................10 

3.1 INTRODUCTION .................................................................................................................................10 
3.2 ICONS USED IN THE TREEVIEW .......................................................................................................10 

CHAPTER 4: MAIN AND POP-UP MENU OPTIONS ............................................................12 

4.1 INTRODUCTION .................................................................................................................................12 
4.2 MENU OPTIONS .................................................................................................................................12 

4.2.1 File Menu ...............................................................................................................................12 
4.2.2 Edit Menu (only in Administrator mode) ...................................................................14 
4.2.3 View Menu .............................................................................................................................15 
4.2.4 Insert Menu (only in Administrator mode) ...............................................................16 
4.2.5 Tools Menu ............................................................................................................................17 
4.2.6 Windows Menu ....................................................................................................................21 
4.2.7 Help Menu .............................................................................................................................21 

CHAPTER 5: DETAIL PAGES ..........................................................................................................23 

5.1 GENERAL ...........................................................................................................................................23 
5.2 EXPLORE ............................................................................................................................................24 
5.3 PROPERTIES ......................................................................................................................................24 
5.4 METADATA .........................................................................................................................................26 
5.5 VALUE INFO ......................................................................................................................................28 
5.6 CONFIGURATION ...............................................................................................................................29 
5.7 XML ...................................................................................................................................................30 
5.8 SOURCE DESCRIPTION .....................................................................................................................30 

PART II VIEWERS ...............................................................................................................................32 

CHAPTER 6: INTRODUCTION .......................................................................................................32 

6.1 DATA VISUALIZATION .......................................................................................................................32 

CHAPTER 7: MAP VIEW ...................................................................................................................34 

7.1 INTRODUCTION .................................................................................................................................34 
7.2 LAYER TYPES .....................................................................................................................................35 
7.3 ACTIVE LAYER ...................................................................................................................................36 



  User Guide WoonZorgWelzijn Verkenner 5.88 

 -  - 4 

7.4 TOOLS ...............................................................................................................................................36 
7.5 LEGEND .............................................................................................................................................40 

7.5.1. pop up menu ......................................................................................................................42 

CHAPTER 8: DATAGRID ...................................................................................................................45 

8.1 ACTIVATING A DATAGRID ................................................................................................................45 
8.2 DATAGRID .........................................................................................................................................46 
8.3 TOOLS ................................................................................................................................................47 

CHAPTER 9: HISTOGRAM VIEW ..................................................................................................49 

9.1 HISTOGRAM VIEW .............................................................................................................................49 

CHAPTER 10: INSERT CLASSIFICATION AND PALETTE................................................50 

10.1 CLASSIFICATIONS AND PALETTES .................................................................................................50 
10.2 INSERT CLASSIFICATION AND PALETTE DIALOG .........................................................................51 



  User Guide WoonZorgWelzijn Verkenner 5.88 

 -  - 5 

 
 

PART I GENERAL STRUCTURE 

Chapter 1: Introduction 

1.1 Main components of the WoonZorgWelzijn Verkenner 

The WoonZorgWelzijn Verkenner is a software system that contains the following 

components: 

- The GeoDMS Engine(Geographic Data and Model Server), a generic set of dll’s 

that control, retrieve, store and calculate the primary data and model results  

- The GeoDmsGui, a generic client application that visualizes the primary data, 

the model results and the calculation logic with a set of primary data viewers. 

Furthermore it supports the user in extending/editing the model logic, importing 

and exporting new primary data and savings all these ‘settings’ in a new 

configuration.   

- The (default) configuration. A hierarchical set of configuration files that describe 

the primary data, the model logic, and the way to visualize both.  

- A set of primary data files that are configured in the WoonZorgWelzijn Verkenner 

configuration in tiff, shape, dbf and MsAccess format. 

 

This user guide mainly focuses on the GeoDmsGui. How to set up a configuration is 

described in the modeler’s reference. These references can be found on the web site 

of Object Vision (http://www.objectvision.nl/GeoDMS). Information about the 

example data can be retrieved as meta data in the system (see paragraph 5.5, Detail 

Pages > Metadata).   

 

The GeoDmsGui is the user interface of the system. As mentioned above the purpose 

of the application is to: 

- View all the primary data and model results. A hierarchical structure is used in 

the configuration to find the requested information (data element). This 

hierarchical structure of so-called tree items is presented in a Treeview. With a 

set of viewers the primary data as well as the model logic can be visualized. 

- Adapt or extend the model logic or the way to visualize data by initiating new 

cases, create new or edit existing expressions and classifications. Also data can 

be exported in different data formats. 

- Store and retrieve the settings of the visualization of the primary data or model 

results in a desktop or the complete configurations with all calculation rules 

in/from a new configuration. 

 

The GeoDmsGui is a Windows based application. This user guide does not describe 

the generic Windows functionality like how to close, maximize or minimize a window. 

For more information on these topics refer to your Windows user guide. An Internet 

connection and installed browser is preferred, as the most actual help can be found 

at the above mentioned web site.  

 

http://www.objectvision.nl/GeoDMS
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1.2 How to read this guide 

This guide focuses mainly on the end-user, who views the primary data, calculates 

model results, initiates new cases and makes limited extensions and editions to the 

configuration. A detailed description of the structure of the client application, the 

different viewers and the composers is, therefore, described. This user guide does 

not contain sufficient information for modeler’s to setup a new configuration or a new 

calculation scheme. For this purpose we refer to the modeler’s reference, describing 

the basics on how to configure a model with the Geo DMS. 

 

This guide is split into two parts. Part 1 describes the generic structure of the 

application, the menu options and the three main panels in the desktop (the 

Treeview, the Detail Pages and the Eventlog). Part 2 focuses on the data viewers 

that can be used to visualize primary data, model results and calculation/model 

logics.  

 

1.3 System requirements 

See for the latest information on the system requirements the Object Vision web 

site.  

 

 

http://www.objectvision.nl/GeoDMS/SystemRequirements.htm
http://www.objectvision.nl/GeoDMS/SystemRequirements.htm


  User Guide WoonZorgWelzijn Verkenner 5.88 

 -  - 7 

Chapter 2 Desktop components 

2.1 Main components of the application 

After activating the application, the following window is presented (Windows Vista 

layout): 

 
figure 2.1: Main window of the WoonZorgWelzijn Verkenner 5.88 

 

In this main window the following components can be distinguished: 

 

 
figure 2.2: Title bar with product name and opened configuration 

 

 

 
figure 2.3: Menu bar with main menu options  

 

 

figure 2.4: Toolbar with view specific tools and toolbar logo 
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figure 2.5: Treeview with root item expanded. 

 

figure 2.6: View area in which data viewers can be activated. 

 
 

figure 2.7: Status bar presenting hints and status information. 

 
These components, except for the Treeview, are always visible. The Treeview can be 

closed (and re-opened) with the menu option View>Tree, or with the ALT-0 keyboard 

combination. If opened, the view is always positioned at the left side of the main 

window. 

 

Two more components are always positioned at a fixed location. The Detail Pages, to 

be opened and closed with the menu option View>Detail Pages, or with the ALT-1 

keyboard combination, are always positioned at the right side of the main window. 

The following figure shows an example of the Detail Pages for the root item:    
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figure 2.8: Detail Pages opened for the root tree item 

 

The Detail Pages are a set of tabs that present information on the selected Treeview 

item. These pages will be described in detail in chapter 5 

 

The third component that is always opened at the bottom of the main window is the 

Eventlog view. This view can be opened and closed with the menu option View> 

Eventlog, or with the ALT-2 keyboard combination. The view shows the events that 

are executed by the application, as presented in the following example: 

 
figure 2.9: Eventlog view with start up events of the GeoDmsGui 

 
This Eventlog is mainly interesting for experienced users to analyze which actions are 

executed. The messages occurring in this log will not be described in this guide. 

 

The three mentioned components (Treeview, Detail Pages and Eventlog) have a fixed 

position. The size of these components can be adapted with a minimum and 

maximum size. The appearance of these components, the width of the Treeview and 

the Detail Pages and the height of the Eventlog is stored in the user specific 

configuration settings of the registry. This means the next time the application is 

started, the size of the components will be maintained.  
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Chapter 3: Treeview 

3.1 Introduction 

The Treeview is the main navigation component within the application. It presents 

the hierarchical structure of a configuration in a Windows Explorer view. By default 

the root and the first level items are shown (the root item is expanded). Each item in 

the tree (called a tree item) is presented with a name and an icon. The main function 

of the icons is to show the default viewer for each tree item. In paragraph 3.2 these 

icons are explained. 

 

The selected item in the Treeview is the active item in the application. This is an 

important concept, as many functions of the application work on the active tree item. 

By clicking the right mouse button a pop-up menu can be activated, with a set of 

menu options that work on this active tree item. This also applies to most main 

menu options and to the Detail Pages. The pop-up menu options and most main 

menu options are described in chapter four. The Detail Pages are described in 

chapter five. 

 

3.2 Icons used in the Treeview 

The main purpose of the icons is to show which default viewer is used for an item. 

Double clicking or pressing the Enter key on a selected tree item activates this 

viewer. The following icons are used to indicate this default viewer: 

 

 Data item that can be viewed in a map. This implies the domain of the data 

item has a geographic relation (see modeler’s reference for how to configure a 

geographic domain unit). Dependent on the geographic domain, the data is 

visualized in a grid, point, arc or polygon layer. 

 Data item that cannot be visualized in map (has no geographic relation) but 

can be viewed in a Datagrid.  

 

The following two icons do not indicate the default viewer, but indicate data items 

with a specific function (classifications and palettes, see chapter 10). 

 

 Data item that contains a classification (a set of classes). A classification can 

be made or edited with the classification and palette composer, see chapter 10 

 Data item that contains a palette (a set of color values that correspond with a 

classification). A palette can be edited with the palette composer, see chapter 

10 

 

Not all tree items are data items. For the non-data items (these items cannot be 

viewed with a primary data viewer), the following icons are in use: 

 

 A tree item with no data item and subitems that also have no data items. The 

icon is  

used for containers grouping other containers or units.  

 A tree item with no data item, but with data items as subitems. All subitems of 

this item with the same domain unit can be viewed in a Datagrid. 

 A tree item with no data item and no subitems, e.g. a unit  
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Tree items can have a different status. Within the 5.88 version five status types are 

distinguished: 

1. Invalidated: a tree item has an external storage configured but the data is not 

yet read from the storage, or the item has an expression (which can also apply to 

units) and the results are not yet calculated.  

2. Validating: the application is updating the tree item (reading data from an 

external storage or calculating).  

3. Calculated: the application succeeded in reading/calculating the results. For data 

items this status means the data items can be visualized. 

4. Valid: the results are calculated and the integrirty checks configured for the item 

and it’s suppliers are met. 

5. Failed: the application did not succeed in updating the results or the integrity 

checks are not met. In the first case the results are not avalaible; an error is 

raised indicating what problem occurred while updating the tree item. In the 

second case, the results are available and can be presented in a view; a warning 

color indicates the results are not valid 

 

The application controls when and how to update tree items. If a user requests a 

view on a data item, the required tree items are first updated, before the results are 

presented in the view. If a tree item has become valid, this status is ‘stored’ until 

changes are made in the calculation rules. This means the second time the same 

view (or another view requiring the same data items) is requested, the data item is 

already valid and the results can be visualized immediately. 

 

Parameters (data items with one value) in the Treeview are presented with their 

status (invalidated or failed) or with their actual value (if their status is valid). See 

the following example: 

figure 3.1 case parameters before updating          and after updating 
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Chapter 4: Main and pop-up menu options 
 

4.1 Introduction 

 
The main and pop-up menu options are related. With the pop-up menu options the 

user can activate functions on the selected tree item. The related main menu options 

also function on the selected tree item. The main menu additionally contains a set of 

generic functions like saving a configuration or tiling the viewer windows. In this 

chapter the main menu options are described. If the option can also be activated 

from the pop-up menu option this is indicated by (P). 

4.2 Menu options 

4.2.1 File Menu 

 
figure 4.1:  File menu 

 
Open Configuration File: Open a Windows file dialog to select a new configuration. 

The current configuration is closed with a question whether or not the changes must 

be saved.  
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Save Configuration As: Open a Window file dialog to specify a new root 

configuration file (or select an existing root configuration file that will be 

overwritten). In subdirectories the whole configuration will be saved. If a 

configuration is saved to a file that is read only, or if it’s configuration files in a 

subfolder are read only, an error is raised. 

 

Reopen current configuration (new in 5.88):  Reopens the current configuration 

with the current and active expanded item and desktop. If a configuration is edited, 

this way the configuration can easily be reopened in the same state. 

 

New Desktop: Create a new desktop, based on a desktop template. A desktop is 

defined as the set of opened map and data viewers, including the specification of 

the: 

- set of layers and their order in each map view with the properties  

- visible 

- for thematic layers, the used classification  

- The area of interest in each map view  

- The set of columns, column widths and sort order in each Datagrid   

After activating this option, a dialog is presented in which a desktop template can be 

chosen. This offers the possibility of making a new desktop, based on an existing 

desktop functioning as a template. If no desktop templates are available, only the 

empty desktop option can be activated to make a new desktop. In the next dialog a 

name must be specified for the desktop. The active desktop name is presented in the 

status bar of the application:  

 

Open Desktop: Open a dialog to select a desktop from the available desktops in the 

current configuration. The selected desktop is opened. 

 

Set Startup Desktop: Open a dialog to select a desktop in the current configuration 

that is used as startup desktop each time the current configuration is opened. 

 

Save Desktop to file: Saves the desktops in the active configuration to a seperate 

configuration file 

 

Export Primary Data (P): Export primary data to an Ascii grid, Bitmap or Ascii 

attribute. The option is only active for the relevant data items. Select the menu 

option and choose from the sub menu the requested data format.  

 

Export Viewports: Exports the set of opened viewports to bitmaps. In 5.88 a 

viewport is the part of the mapview, in which the actual geographic data is 

shown.The export settings (including export directory and file names) are configured 

in the ExportSettings configuration. Activating this option results in a new dialog, in 

which all active viewports are shown and selected. From this list you can also select 

a subset of the viewports to be exported. Information about the number of 

pixels/bitmaps per viewport is also presented.  

 

Recent configurations: The recently opened configurations are presented, in order 

to easily select one of these configurations. The number of configurations is limited 

to nine. 

 

Exit: Exit the application. Before exiting, the application asks first if the 

configuration should be saved. If YES, and if the default configuration (configuration 
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that is part of the installation) is active, the save as dialog is opened to specify a new 

name for the configuration. This way the user is prevented from overwriting the 

default configuration. If NO, a new name for the configuration can be specified. For 

other configurations answering YES overwrites the active configuration. 

 

 
4.2.2 Edit Menu (only in Administrator mode) 

 
figure 4.2:  Edit menu  
 
Config Source (P): Edit the config source of an item with the DMS editor (Crimson 

Editor is advised, see here). The editor needs to be specified in the Tools > Options 

> General Settings > DMS editor option (see 4.2.5). The DMS editor is activated with 

the relevant dms file and, if supported by the eidtor, the correct line and position. 

After editing and saving, use the File > Reopen current configuration open to open 

the configuration in the same state (expanded and active item and desktop).  

 

Definition (P): Activate 

- the Edit Classification and Palette dialog if the selected data item is a 

classification classes item.See chapter 10 for more information on classifications 

and palettes.  

- the Edit Palette dialog if the selected data item is a color palette. 

- the Expression dialog for all other items. This dialog is used to set or edit the 

expression of a tree item. See chapter 16 for more information on the Expression 

dialog. 

 

Classification and Palette (P): Activate the Edit Classification and Palette dialog 

for all data items for which a classification and palette is configured. This 

classification and palette can be configured for the data item itself or for its values 

unit. See chapter 10 for more information on classifications and palettes. 

 

 

Update Treeitem (P): Update a data item with the status invalidated. The option is 

only enabled for invalidated data items. The result of the action can be a valid data 

item (update succeeded) or a failed data item (update raised an error).  

 

http://www.objectvision.nl/GeoDMS/projects/SoftwareDev.htm
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Update Subtree (P): Update the subitems of a tree item. The option is only 

enabled for tree items with invalidated subitems. The result of the action can be a 

valid set of subitems (update succeeded) or one or more failed items (update raised 

an error).    

 

Invalidate TreeItem (P): Explicitly invalidate an item to ensure it will be 

recalculated when the results are requested in a view. 

 

Copy TreeItem (P): Copy a tree item to the Windows clipboard, in order to paste 

the item in another container. 

 

Paste TreeItem (P): Paste a copied tree item with the same name. An item needs 

to be copied first, before the paste option becomes enabled. As two tree items with 

the same name are not allowed in the same container, a copied item cannot be 

pasted in the same container (the option is disabled). Be Aware: Pasting items in a 

new container can cause invalid tree items (e.g. because the container of the copied 

item a using or storage property was configured, which is not a property of the 

copied item and, therefore, not copied to the new item). Primary data is not copied, 

therefore, the copy/paste functionality cannot be used to make a copy of a 

classification. Use the save as function in the edit classification and palette dialog for 

this purpose. 

 

Delete TreeItem (P): Delete a tree item with all its subitems. If a tree item cannot 

be deleted, because it is referred to by other tree items, (e.g. in an expression), a 

message is presented indicating the item could not be deleted. First delete the 

referring tree item before the referred tree item can be deleted. Still deleting tree 

items can cause some incorrect working functionality. Be cautious with deleting tree 

items, especially with items referred to from multiple places. 

 

Edit Label ActiveWindow: The Active View (see part II of this reference for 

information on viewers) can be provided with a label, indicating the contents of this 

view. The menu option becomes active if a view is opened. In a text box, a view 

label can be given. The view label is presented in the title bar of the view.  

    

4.2.3 View Menu  

 
figure 4.3:  View menu 
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Default (P): Activate the default viewer for the selected data item. This option is 

only enabled for data items. The default viewer for all data that can be visualized in a 

map, is the map view. For all other data items the default viewer is the Datagrid 

view. 

 

Map (P): Activate the map view for the selected data item. In a submenu the layer 

type must be chosen (in this version only default is implemented). See chapter 7 for 

more information on the map view and the layer types. The map view option 

becomes enabled if the selected data item can be visualized in a map view. 

 

Datagrid (P): Activate the Datagrid for the selected data item. See chapter 8 for 

more information on the Datagrid. The Datagrid option becomes enabled if the tree 

item can be visualized in a Datagrid.  

 

Histogram (P): Activate the histogram for the selected data item. See chapter 9 for 

more information on the histogram. The histogram option becomes enabled if the 

tree item can be visualized in a histogram. 

 

Process Schemes (P): Activate the process scheme for the selected tree item. In 

the submenu the process scheme type must be selected.  

 

Treeview: Show or hide the Treeview at the left side of the main window. See 

chapter 3 for more information on the Treeview. 

 

Detail pages: Show or hide the Detail Pages at the right side of the main window. 

See chapter 5 for more information on the Treeview. 

 

Eventlog: Show or hide the Eventlog window at the bottom side of the main 

window.  

 

Toolbar: Show or hide the toolbar at the top side of the main window. 
 
4.2.4 Insert Menu (only in Administrator mode) 

 
figure 4.4: Insert menu 

 

The first four menu options insert items or sets of items at the location of the 

selected tree item: 

 

Container (P): Insert a new container as subitem of the selected tree item. The 

Insert container dialog is activated. See chapter 12 for more information on 

containers and this dialog. 
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Data Item (P): Insert a new data item as subitem of the selected tree item. The 

insert data item dialog is activated. See chapter 13 for more information on this 

dialog. 

 

Entity/Unit (P): Insert a new entity or unit as subitem of the selected tree item. 

The Insert Entity/Unit dialog is activated.  

 

External Data Link (P): Insert a link to an external data source, in the GeoDmsGui 

5.88 this is implemented for Ascii grids, dBase files, ODBC sources and Shape files. 

They will be configured as subitem(s) of the selected tree item.  

 

The two options below the line insert sets of items at a pre-defined, configured 

location in the tree. This location is configured in the config.ini file accompanying 

each configuration. The location is independent of the selection of the active tree 

item. 

 

Case (P): Insert a new case as subitem of the specified case directory, including the 

name of the calculation scheme. The Insert case dialog is activated.  

 

Classification and Palette (P): Insert a new classification and palette in the 

classification container. The Insert Classification and Palette dialog is activated. See 

chapter 10 for more information on classifications, palettes and this dialog. 

 

 
4.2.5 Tools Menu 

 
figure 4.5: Tools menu 

 
Options: activate the following dialog to set some general properties: 
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figure 4.6: General settings dialog 

 
The dialog is split up in two tabs. The General settings tab is used to configure 

settings that apply to all configurations. These settings are stored in the user specific 

registry setting. The Current configuration tab is used to configure settings that 

apply to the current configuration. These settings are stored in the configuration 

specific config.ini files. 

 

In the General settings tab the following settings can be configured: 

Url:  The url that is used in the about box for more information on the data and 

model server 

 

Helpfile: the url that is used for on line help on the data and model server. 

 

It is not recommended to change the Url and Helpfile settings. 

 

DMS editor: the path to an external text editor, including some parameters for how 

to position the cursor at a specific location in a configuration file. This functionality is 

used if errors occur in the configuration. If a text editor is configured, the 

GeoDmsGui can open the configuration file and, if supported by the editor, indicate 

to the position in the file where the error was noticed. The following parameters can 

be set: 

%F: file 

%L: line number in the file 

%C: column number in the file 
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The exact syntax for the configuration depends on the used editor. The following 

examples show the syntax for three different common used text editors: 

- Textpad: C:\Program Files\TextPad 4\TextPad.exe %F (%L, %C) 

- UltraEdit: D:\program files\ultraedit\uedit32.exe %F/%L/%C 

- Notepad: Notepad.exe %F (Notepad cannot be activated with a line and column 

number, so only a file can be specified as parameter) 

 

User modes: The application can be configured in two modes: 

- User mode. The administrator mode check box is not selected . 

- Administrator mode. The administrator mode check box is selected . 

 

There are three differences between both modes: 

- Hidden tree items. A tree item can be configured hidden by configuring the 

DialogType property to hidden. In the user mode these items are not shown in 

the Treeview, the Detail Pages and the process schemes. In the administrator 

mode all items are shown. 

- The menu (and pop up menu) options Edit and Insert are only available in the 

administrator mode. 

- Editing the properties. In the user mode the dialogs are used to set properties for 

specific tasks. The properties in the detail page Properties (A) cannot be edited. 

In the administrator mode some of these properties can be edited. Be aware that 

editing properties in this dialog can make the application unstable. 

 

If the Administrator mode is selected, two other options can be selected: 

1. TracLogFile. If this option is selected, a trace.log file is generated by the 

application. The trace.log  file logs information about the calculation processes 

and can be used for debugging purposes. If the option is not selected, the file is 

not generated. 

2. Show State Colors in Treeview. This option shows the state of an item (as 

described in & 3.2), visualized in different colors in the Treeview. The colors can 

be configured in the Current configuration tab 

3. Suspend View Updates to favour User Interaction. This option allows a user to 

interact with the system, even if the system is calculating results or updating 

views. The option can cause some errors and is therefore not supported in the 

used mode.  

 

LocalDataDir:  

The LocalDataDir is used as base directory for (temporary) results like the 

CalcCache. See http://www.objectvision.nl/GeoDMS/directories.htm for more 

information on directories and placeholders in the GeoDMS. The default setting for 

the LocalDataDir is C:\LocalData. This default setting can be overruled here. 

 

SourceDir: 

The SourceDataDir is used as base directory for (large, read only) source data files, 

often used in multiple projects. See 

http://www.objectvision.nl/GeoDMS/directories.htm for more information on 

directories and placeholders in the GeoDMS. The default setting for the 

SourceDataDir is C:\SourceData. This default setting can be overruled here. 

 

 
 

 

http://www.objectvision.nl/GeoDMS/directories.htm
http://www.objectvision.nl/GeoDMS/directories.htm
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The Current configuration tab presents the following dialog: 

 
 figure 4.7: Current configuration dialog 
 
No-data color: Activate the button to select the no data color in the map views of 

the current configuration. 

 

Background color: Activate the button to select the background color of the map 

views of the current configuration 

 

Treeitem View Color Settings: Default these options are disabled. If in the 

General settings page the Administrator mode is selected, the option: Show State 

Colors in Treeview can be selected. The state of an item (as described in & 3.2) is 

then visualized in different colors in the Treeview. The colors for Valid, Invalidated or 

Failed items can be selected in this dialog. 

 

Default Classification Ramp Colors: In the classification and palette composer 

(see chapter 10), colors are default chosen for the first and the last class. These 

colors can be selected with this dialog. 

 

Minimum size for DataItem specific swapfiles in CalcCache: This setting is 

used to indicate the size of items that need to be saved in the CalcCache on disk. It 

is advised not to adapt this setting.  
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4.2.6 Windows Menu 

 
figure 4.8: Windows menu 

 

Tile: Tile the currently opened data viewers. 

 

Cascade: Cascade the currently opened data viewers. 

 

Close all: Close all currently opened data viewers. 

 

Windows: A list of all opened data views, the active view is indicated by a dot. 

A view can be activated from this list. 

 
 

4.2.7 Help Menu 

 
figure 4.9: Help menu 

 
Online Help: Open the Internet Browser installed on the local machine with the url 

specified for the Helpfile in the Tools > Options dialog.  

 

About: Open the About box for information on the version and development team of 

the application  

 

Index: An optional reference to an index of relevant documents for an application 
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Copyright Notice: An optional reference to the Copyright information for an 

application 

 

Disclaimer: An optional reference to a Disclaimer for an application 

 

Data Source Reference: An optional reference to a description of the data sources, 

to be used in reports with results of the application.  
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Chapter 5: Detail Pages 
 
The Detail Pages present a detailed overview of information on the selected tree 

item. The Detail Pages are split up into eight different tabs, General, Explore, 

Properties, MetaData, Value Info, Configuration, XML and Source Descr. The tabs are 

described in the next paragraphs. 

 

The Detail Pages show (generated) HTML documents, similar to an Internet Browser. 

This means the blue underlined texts are references that can be clicked. If the text 

refers to a tree item, clicking means this item is activated. If the text is the label of a 

property, a dialog is presented related to this property. The back, forward, stop and 

refresh buttons function as in a normal Internet Browser.  

5.1 General 

This page presents the most relevant properties of a tree item and it’s related 

domain and values units (if applicable). The following example shows the General 

page for the tree item: /Brondata/buurt/nrPersonen 

 
figure 5.1: Properties (G) detail page for the tree item Brondata/buurt/nrPersonen 
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The detail page shows: 

- the full name, status and values type of item and if configured the class diagram 

to be used for classification of the data. 

And, if the tree item is a data item:  

- the domain for which the item is available, including the element type, if relevant 

the  geographic projection and the range (nr elements) of the domain.  

- the values unit in which the data item is configured, including the element type, 

the range of the values, the number of elements and, if configured, the 

classification scheme for the values unit. 

- a calculation rule (expression) for a data item for which an expression is 

configured. 

- a data target (storage) for a data item read from a data source.   

5.2 Explore  

The Explore detail page shows the name, description and storage type of the 

subitems of the selected tree item. This page is used to view a list of items with their 

descriptions and storage types. The following example shows the Explore detail page 

for the item: /Brondata 

 
figure 5.2: Explore detail page for the tree item: /Brondata 

5.3 Properties  

This page shows the properties of a tree item. The following example shows a part of 

the Properties detail page for the tree item: /Brondata/buurt/nrPersonen 
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figure 5.3: part of Properties detail page for the tree item 

Brondata/buurt/nrPersonen 

 

The Properties page shows all relevant properties of the selected item, including 

system properties, indicated by the keywords CLASS. By double clicking on a 

property row, a dialog is activated with the whole text of the property and it’s 

current value, as shown in the following example for the property full name: 

 

 
 figure 5.4:Textbox presenting the full name of the selected tree item    

 

This textbox can be used to copy information to the Windows clipboard. In the 

administrator mode (see chapter 4, menu option Tools > Options > Administrator 

mode), the textbox can also be used to set values for some properties. This 

functionality is only advised for experienced users, as setting incorrect values for 

properties can create an unstable system, resulting in multiple errors. 

 
. 
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5.4 Metadata 

For more information on a tree item, a url property can be configured that refers to a 

document on the local machine or on the web. The document (which can be an. html 

file or any other file format that is supported by Internet Explorer and which 

application is installed on the local machine, like MsExcel, MsWord, etc.) is presented 

in the detail page Metadata. In WoonZorgWelzijn Verkenner the metadata detail 

page is only used to specify the export settings for exporting map view ports to 

bitmaps. 

 
Open the meta data detail page on the item: ExportSettings 

 
figure 5.5: Metadata detail page for item ExportSettings 
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In this dialog the following options can be configured: 

 
Size 
 
Paper size:  

The paper size defines the export area of the resulting bitmap. The following options 

are available: 

- map window size: the export area is the area of interest visible in the map view 

- a specific paper size: the expot is based in the center point of the area of interest 

in the map view and the selected paper size. 

- user defined: the width and height options become enabled. The expot is based 

in the center point of the area of interest in the map view and the specified paper 

width and height. 

 

Orientation:  

For specific and user defined paper sizes, this option indicates if a landscape or 

portrait export is desired. 

 

Margins: 

For specific paper sizes, margins can be set. The margins influence the width and 

height of the resulting bitmap. 

 
 

Scale 
 
The user can define the scale of the resulting map view with the following options: 

- user defined: the 1 to .. option becomes enabled to indicate that 1 cm in the 

map is the specified value in cm’s in the real world 

- based on map windows: the same scale is used as in the exported map 

window 

- a specific scale: the available options are suggested scale levels. 

 
 

Quality 
 
Dots per inch(dpi): 

This quality setting indicates how many dots will be printed per inch, based on the 

allowed dpi of the printer. Increasing this number results in better quality maps (if 

supported by the printer), but also results in more/larger bitmaps. Ms Office products 

like PowerPoint usually assumes images to be around 100 dpi, this means the image 

size need to be adjusted if files with largere dpi are imported. 

 

View distance factor: 

A factor indicating if the final result is to be seen at the distance of a screen of e.g. of 

a poster, which is usuallye looked ad from a larger distance. A large view distance 

factor means the objects in the map are presented larger. The default value is 1. 

 

Subdots per paper dot: 

For future use, the default value is 1  
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After adjusting these values, activate the save settings button to save the settings 

for the current session. In 5.88, if the application is ended, these settings are not 

saved to the configuration. The next time the application is run, the original setttings 

apply again. 

5.5 Value Info 

The value info detail page is used for two purposes: 

 

1. To present general statistics about a numeric data item. 

2. To present the whole path of how a certain data value in the Datagrid or in the 

map view is constructed. 

 

1. The general statistics is shown if a numeric data item is selected in the tree and 

the detail page value info is activated: 

 

  
figure 5.6: Value info detail page for tree item: /Brondata/buurt/nrWoningen 

 

In this page the following statistics are presented: 

Count:  the total number of items of the data item 

Nr Nulls:  the number of missing data elements of the data item 

Nr Values:  the number of non-missing data elements of the data item 

Maximum:  the maximum value of the data item 

Minimum:  the minimum value of the data item 

Sum:   the sum of all values of the data item 

Average:  the average value of the data item 

Variance:  the variance of the data item 

StdDev:  the standard deviation of the data item 

 

The Statistics is only shown if the data item is valid (as it can take some time to 

update a tree item). If the item is not yet calculated, a message is shown that the 

data item is invalidated. In that case, press the Ctrl-U combination to update the 

tree item first. If the item is not a data item or not numeric, a message is shown 

which indicates the statistics cannot be shown. 
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The results in the Statistics view can differ slightly from calculated aggregated 

values. The Statistics view calculates all presents values in a float64 format. If an 

aggregation is performed on a float32 data item, the results are round off after the 

calculations to a float 32 format.   

 

2. The construction of a data value in the Datagrid or map view is activated by 

selecting a cell in the Datagrid or by activating the I-tool in the map and selecting a 

certain grid cell in the map. If the value info page is the active detail page, all the 

steps are presented on how a data value is constructed from the source data and the 

performed calculations: 

 

 
figure 58: construction of a data value in the data grid view for the tree item: 

KTO/meerdere_jaren/jr2007_jr2008/buurt/vrg84_HeeftKoopIntentie 

 

If e.g. the cell with the value 535 is selected in the table and the detail page info 

value is active, the information as shown in the example is presented. This 

information describes how the value is calculated and which suppliers are used. The 

next sentences indicate the values of the suppliers. Use the hyperlink to find out how 

these values are calculated and what their suppliers are.  

5.6 Configuration 

The configuration tab shows the configuration syntax (.dms of the selected item (and 

if available, it’s subitems). The following example presents the configuration detail 

page for the tree item: /Brondata/woning 
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 figure 5.8:  Configuration detail page for the tree item: /Brondata/woning 

 

More information on how to configure can be found in the modeler’s reference on 

http://www.objectvision.nl/GeoDMS. 

5.7 XML 

The XML tab shows the xml configuration syntax (.xml) of the selected item (and if 

available, it’s subitems). The following example presents the XML detail page for the 

tree item: /Brondata/woning 

 

  
figure 5.8:  XML detail page for the tree item: /Brondata/woning 

 
More information on how to configure can be found in the modeler’s reference on 

http://www.objectvision.nl/GeoDMS. 

5.8 Source Description 

 
This detail page describes, if relevant, the source information for a data item. The 

source information can be configured in the source property. If not configured, the 

data sources names(files) are presented. An example is shown in the next figure: 
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 figure 5.10 Source Description Detail page for the /Brondata/buurt/nrPersonen 
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PART II VIEWERS 

Chapter 6: Introduction 

6.1 Data visualization 

The set viewers in the GeoDmsGui are used to visualize source data and calculated 

model results. As almost all data in the applications is geographically related, the 

main viewer is the map view. This map view is configured as the default view for all 

items that are geographically related. More information on the map view can be 

found in chapter 7. The default view is activated by double clicking on a tree item, by 

selecting a tree item and pressing the Enter key or by activating the default view 

action from the main or pop-up menu. The default viewer for data items is indicated 

in the Treeview by the presented icon (see paragraph 3.2). 

 

For data items that cannot be visualized in a map (like a parameter), the default 

view is the Datagrid. All data items can be visualized in a Datagrid, by activating the 

Datagrid view main or pop-up menu item. The Datagrid is described in detail in 

chapter 8. The third type of view that can be applied to primary data is the 

histogram view. This view is not configured for any item as default view, but can be 

activated with the histogram view main or pop-up menu item. The histogram is 

described in chapter 9. 

 

As well as the views for the primary data, the GeoDmsGui also offers views on the 

configured calculation and model logic. Therefore the so-called process schemes are 

implemented, allowing the user to get a scheme of the subitems, suppliers and 

calculation logic of a tree item. These process schemes are described in detail in 

chapter 10. 

 

All views are positioned in the view area of the application. The first view is always 

opened maximized. Be aware that the minimum, restore/maximize and close buttons 

of this view are located at the top right corner of the window in the main menu bar, 

as shown in the next figure. 
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 figure 6.1: WoonZorgWelzijn Verkenner with map view activated for tree item 

/Brondata/voorziening/alle/code 

 
If a second view is opened, this view is opened maximized if the other views are also 

maximized. Otherwise the window is opened in the normal Windows state. 

 

Each viewer has it’s own set of tools that are located in the taskbar when the view is 

activated. In Figure 6.1 the tools of the map view are presented. All views are listed 

in the Window main menu option. With this menu option the views can be tiled, 

cascaded and all windows can be closed.  

 

Buttons for maximized view 
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Chapter 7: Map View 
 

7.1 Introduction 

The map view presents data items that can be geographically located. Each map 

view has a projection, indicating the coordinate system. In WoonZorgWelzijn 

Verkenner the projection used is usually the "Rijks Driehoek (RD)" coordinate system 

for all geographically related data items (other coordinate systems are possible, but 

the source data is usually in RD Coordinates). A map view consists of layers, each 

layer is related to one or more data items. All geographically related data items 

using the same projection can be combined in the same map view window. They can 

also be opened in a multiple separate map views. The number of opened map views 

is not limited. 

 

In the example of figure 6.1 a map view is presented with three layers: 

- a reference grid layer of the Amsterdam Zuid as 

- a point layers of services, with colors/symbols indicating the type of services 

  

In paragraph 7.2 the available layer types for a Geo DMS map view are described. A 

map view can be activated from the Treeview by selecting tree items that can be 

geographically related. These items are indicated with a map icon ( ).  

 

A new map can be created or a layer can be added to an existing map by selecting a 

tree item and activating one of the following actions listed in the table. The result of 

the action, based upon whether or not there is already an active map view opened, is 

described. 

Action No active map view  Active map view 

- Double click on selected 

tree item  

New map window Layer opened in active 

map view 

- Enter key on selected tree 

item 

New map window Layer opened in active 

map view 

- Main/pop-up menu option 

Default View 

New map window Layer opened in active 

map view 

- Main/pop-up menu option 

Map View  

New map window New map window 

- Ctrl-M on selected tree 

item 

New map window New map window 

- Drag and drop to view 

area/active window 

New map window Layer opened in active 

map view 

   

In the WoonZorgWelzijn Verkenner, a reference grid layer is configured as 

background layer. This means in all map views this layer is visualized automatically 

when the view is created (see the modeler’s reference for how to configure a default 

layer). The background layer (called Achtergrond) is shown in the legend, the pop-up 

menu options (see 7.5.1) can also be applied on this layer.  
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7.2 Layer types 

In a map view layers can be visualized in different ways. Within the Geo DMS a 

difference is made between: 

 

Reference/background layers:  
 

 
 
 

 
 

 

Figure 7.1: Examples of reference/background layers with polygons/labels and grid 

data 

 

Layers used to refer in an intuitive way the data to be visualized. Reference layers 

are usually: 

- topographic polygon layers (showing the boundaries of areas like in the example 

polygons), sometimes with a label configured (as in the example) 

- grid layers which can present different detail information at different zoom levels. 

In Geo DMS applications one or a set of reference layers is often configured as 

default layer (see the modeler’s reference for how to configure a default layer). The 

default layer (set) has by default one entry in the legend.  

 

Attribute data layers: 

Layers use to present data related to a geographic domain. This domain consists of 

geographic objects, which can be grid cells, polygons, arcs or point as in the 

following examples:  

Figure 7.2: Examples of attribute data layers with grid, polygons, arcs and points 

data 

 

In these layers, the features (grid cell, polygon, arc, point) are visualized with one or 

multiple visualization styles (colors, symbols, size etc).The possible styles are 

dependent of the layer type. The style values refer to classes in a classification 

scheme. This implies that a palette (e.g. color, size, symbol) and, if the data item is 

not yet classified, a classification is needed to visualize a data item as a thematic 

layer. If no classification is found for the data item or it’s values unit (see chapter 10 

for more information), a data item can not be visualized thematically. 

 

Layers can be activated with the actions listed in paragraph 7.1.The grid layer type is 

activated for each numeric data item with a grid domain as domain unit.  
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For the vector data types (polygon, arc en point), the geographic format specified for 

the values unit of the feature data item, determines if the data is visualized as point, 

arc or polygon. 

(see the modeler’s reference for who to configure these values types). 

 

A specific theme of a layer is a text label. Text labels can be used for polygon and 

point layers.  

 

  

   
 
 
Figure 7.3: Examples of labels for polygon and points layers 

 

 
7.3 Active Layer 
The active layer is an important concept since version 5 in each Geo DMS map view. 

The active layer is the layer on which the layer specific (toolbar) functions are 

executed.  

 

A layer can be activated from the legend (see 7.5). In this legend the active layer is 

indicated by a blue background color of the title as in the next figure (the last 

column contains the counts): 

 
Figure 7.4: Examples of an active layer in the Legend 

 
The user can switch between active layers by clicking on the layer title. There is 

always only one one active layer (activating one layer deactivates all other layers). 

By default the last layer added to the map view becomes the active layer. 

 

7.4 Tools  

When a map view is the activated, the set of specific map view tool buttons is 

presented in the toolbar. By default the Zoom in tool is activated, as this is often the 

first action performed. For the neutral state (arrow that performs no action on the 

map view) deactivate the zoom or selection state by re-clicking on the same tool. 

   

The following buttons are available to adapt or query the map view: 

 

  
 
Fit to all layers: action to enlarge or reduce the zoom level and pan the area to 

make the extents of all layers fit in the active map view. 
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Fit to active layer: action to enlarge or reduce the zoom level and pan the area to 

make the extents of the active layer fit in the active map view. 

 
 

 
Zoom in: zoom in tool, presenting the cursor as a magnifying glass with a plus sign, 

which can be used to zoom in, in two ways: 

- Click with the left mouse button at the top left corner of the requested area of 

interest. Keep the left mouse button pressed and move the mouse to the bottom 

right corner, a rectangle is drawn in the map. Release the mouse button and the 

map zooms in to the requested rectangle. 

- Click with the left mouse button on a position in the map and release the button. 

The map is zoomed in with a fixed zoom factor and the cursor position as center. 

The Zoom in tool is configured as default tool. The neutral state (no tool active) can 

be achieved by activating this button. 

 
 

 
Zoom out: zoom out tool, presenting the cursor as a magnifying glass with a minus 

sign, which can be used to zoom out until the full extent of the map is reached. Click 

with the left mouse button on a position in the map and release the button. The map 

is zoomed out with a fixed zoom factor and the cursor position as center. 

 
 

 
Pan: pan tool, presenting the cursor as a semi transparent hand sign, which can be 

used to move the presented layers. To pan, click with the left mouse button at a 

position in the map, keep the left mouse button pressed and move the mouse to the 

requested direction. Release the mouse button and the requested new area of 

interest is drawn. 

 
 

 
Info: information tool, presenting the cursor as an arrow with an i-sign, which can 

be used to query individual features in the map of the active layer (see 7.3). To 

query the values of individual features, click with the left mouse button on the 

requested grid cell, point, arc or polygon. The feature is shown in a new color. The 

information of this feature is shown in two ways: 

- In the legend the values of the attribute of the active layer and all grid attribute 

layers are presented in front of the values unit or in a separate line. 

- If the value info detail page is visible, the whole path for how the value in the 

map view is constructed is presented (see paragraph 5.6 for more information on 

the value info Detail Pages). 

The information tool is related to the active cell in a data grid of the same domain 

unit as information is requested from in the map view.  
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The following six tools are used to (de)select objects. The selected features of 

polygons, arcs and points are colored light blue. For grid cells, a hedge style for both 

interior as border is used to indicate selected cells. 

Selected features are by default added to the earlier selection. Keep the Control key 

pressed to deselect features. Activate the Select none tool to reset the whole 

selection in the active layer.   

 
 
 
Toggle lay-out: action to toggle between three lay-out options of the map view. By 

default the legend and the overview map are visible in each map view. With the 

toggle lay-out tool, the user can select between three options: 

- legend and overview map visible (default) 

- no legend and no overview map visible 

- only legend visible, no overview map 

The tool presents a picture of the lay-out that will be presented if the tool is 

activated. The default tool shows an empty lay-out of the view area. If the tool is 

activated no legend and no overview map will be presented. The tool itself is now 

changed to the following picture: 

 

It shows a legend area in the right part of the view area. If the tool is now activated, 

a legend is presented but no overview map. The tool is again changed to the 

following picture:         

 

It now shows both a legend area and an overview map area. If the tool is now 

activated, a legend and an overview map are presented (the default status of the 

map view). The tool is changed to it’s original picture. 

 

 

Toggle palette: action to toggle between three options of showing/hiding palette 

information the legend. By default palette information is presented in the legend, if 

the number of entries in the palette is less or equal than 32. 

With the toggle palette tool, the user can select between three options: 

- show palette information for each layers with palette information in the legend 

- show palette information for the active layer with palette information in the legend 

- show no palette information for each layer in the legend 

Activate the button to select the next option. The picture of this button will not 

change. 

 

 
 

Toggle Needle Controller: action to toggle between showing and hiding a 

horizontal and vertical grid line, called a needle controller, in the map view. These 

gridlines can be used for accurate navigation (X and Y coordinates are always 

visualized in the toolbar).  
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Toggle Scale bar: Action to toggle between showing and hiding a scale bar in the 

bottom right corner of the map view.  

 

 
 
Copy visible area: action to copy the visible contents of the active map view to the 

clipboard. In case the legend is visible, this legend is also copied to the clipboard. 

The legend can be made    (in)visible with the Toggle layout button. 

 

 
 
Copy full legend: action to copy the full contents of the legend to the clipboard. The 

size of contents of the clipboard is limited, if the data to be copied exaggerates the 

maximum size of the clipboard, an error is generated. 

 

 
 

Export viewport: exports the active viewport to one or a set of bitmaps, using the 

specified export settings. See paragraph 5.4 for information on how to edit these 

settings. All view ports can be exported by using the File > Export Viewports menu 

option. 

 
 
 

Fit to selected features in active layer: action to enlarge or reduce the zoom 

level and pan the area to make the extents of the selected features in the active 

layer fit in the active map view. 

 
 
 
Select individual feature: select tool to select individual features in the active 

layer. A ball pen is presented, with which individual features can be selected (left 

mouse click).  

 
 
 
Select rectangle: select tool to select features with a rectangle in the active layer. 

A ball pen is presented, with which features can be selected. Move the cursor to the 

top left corner of the requested rectangle and press the left mouse button. Keep the 

button pressed and move the mouse to the bottom right corner, a rectangle is drawn 

in the map. Release the mouse button, all features in this rectangle are now 

selected.  

 
 
 
Select circle: select tool to select features with a circle in the active layer. A ball 

pen is presented, with which features can be selected. Move the cursor to the center 

point of the requested circle and press the left mouse button. Keep the button 



  User Guide WoonZorgWelzijn Verkenner 5.88 

 -  - 40 

pressed and move the mouse to the requested size, a circle is drawn in the map. 

Release the mouse button, all features in this circle are now selected.  

 
 
 
Select free area: select tool to select features with a user drawn area in the active 

layer. A ball pen is presented, with which features can be selected. Move the cursor 

to the first point of the requested area and press the left mouse button. Move the 

cursor to the next point and press again. Continue these steps until the complete 

area is drawn. Double click on the last point to select the features in this user drawn 

area. 

 

 
   

Select contiguous regions: select tool to select features within a contiguous 

region. This tool is not relevant for the Ruimtescanner. 

 

 
 
Select all: action to select all features in the active layer. Activate the tool to select 

all features in this layer.  

 
 

 
Select none: action to deselect all features in the active layer. Activate the tool to 

deselect all features in this layer.  

 
 

 
Show only selected: action to toggle between showing only the selected records or 

showing all records in the map view. In case all records are shown, the selected 

records ale colored in the selection color. In case only the selected records are 

shown, the background color of the layer in the legend becomes the selection color. 

7.5 Legend 

The legend of the map view has two functions. The first function is the legend 

function for a map, explaining which layers occur in the map including their values 

units and, if applicable, their classifications schemes. The second function is to 

activate layer specific functionality of the layers in the map view. 

 

An example of a legend for a map view, is presented in figure 7.5: 
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figure 7.5: Map view legend with overview and three layers 

 
The upper part of the legend presents an overview map with the full extent of the 

contents of the configured default layer(s). See the modeler’s reference for how to 

configure a default layer. The purple area indicates the visible part in the map view. 

The overview is used for a geographic reference, but can also be used for navigating 

by dragging the purple area. The overview window is default visible, but can be 

made invisible with the pop up menu from this Legend (see 7.5.1 pop up menu). 

 

All layers in the map view are presented in the legend. The sequence indicates the 

drawing order. The layer at the bottom is drawn first, the following layers are drawn 

next, so the layer at the top of the legend is drawn above all layers. 

 

Each layer in the legend is presented with a title (the name of the data item that was 

requested, or in case this item has a label property configured, it’s label). Below the 

title the values unit of the data item is shown. If the information tool is used, the 

value for the specific object selected in the active layer in the map is also presented 

in this line. 

  

For layers with a classification scheme configured, the palette colors, classes, labels 

and a count of the number of entries in the class are default shown in the legend 

control, in case the number of entries is less than 15. If symbols are defined in the 

scheme, these symbols are also presented. With the pop up menu (see 7.5.1.) the 

user can hide or visualize this palette information for the layer in the legend. With 

the         button the palette information can be shown for no, the active, or for all 

layers. The width of each column van be adapted. Click with the left mouse button 

on the line between the columns, keep the mouse down (a different cursor appears) 

and drag the width of each column to the requested size. 

 

The colors, labels and class values of calculation schemes can be edited from the 

legend. To edit a color, double click on the color in the legend for a Windows color 

dialog. To edit the class values or labels, click on the specific cell in the legend. Type 

a new value or use the F2 key to edit the current value. To edit other aspects of the 
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scheme, like the number of classes, use the Edit Palette pop up menu option for the 

palette dialog (see chapter 10).  

 

A layer in the map view and related in the legend has a visible or hidden state. If a 

layer is hidden in the map view, this is shown in the legend with a grey color. The 

user can toggle between the hidden and visible state by double clicking on the layer 

title. By default a layer is always visible. 

 

With the Ctrl key pressed and the arrows up and down and left and right, it is 

possible to scroll in the legend. The Ctrl Home and Ctrl End key combinations move 

directly to the top and end of the legend. Scrolling becomes relevant if the legend 

information does not fit in the visible area of the screen.  

 

Layer specific functions and some general map settings can be activated from a pop 

up menu, which is shown if a user clicks with the right mouse button on the layer in 

the legend. The options presented are described in subparagraph 7.5.1. 

 

7.5.1. pop up menu 
 

Activating the pop up menu on a layer presents the following menu: 

 
figure 7.5: pop up menu of a layer wonen – centrum -stedelijk 

 
The following options are available 

- Hide LayerControl for layer 

The layer is not visualised in the layer control (e.g. background layers can be 

made hidden when exporting a legend). A right mouse click in the layer control 

on an empty area offers the option to make the hidden layers visible again. 

- LayerControl Font: 

Three options are available for the size of the layer font in the legend. The default 

option is small. The user can set the font size to medium or large. 

- Layer position: 

The sequence of layers in the legend corresponds with the drawing order in the 

map view. This order can be changed with the four submenu options. Grid layers 

drawn above other layers are visualized transparently.  

Only the relevant submenu actions are enabled for the user: 

- Bring Layer to front: The layer will be drawn above all other layers. In the 

legend the layer is moved to the top. The option is only available in case the 

layer is not yet the top layer in the drawing order.  
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- Send Layer to back: All other layers will be drawn above this layer. In the 

legend the layer is moved to the bottom. The option is only available in case 

the layer is not yet the last layer in the drawing order.  

- Bring Layer Forward: The layer is positioned one step higher in the draw 

order. In the legend the layer is moved one place higher. The option is only 

available in case the layer is not yet the top layer in the drawing order.  

- Send Layer Backward: The layer is positioned one step lower in the draw 

order. In the legend the layer is moved one place lower. The option is only 

available in case the layer is not yet the last layer in the drawing order. 

The sequence can also be adapted with dragging and dropping the layer. 

- Remove Layer: The layer is removed from the map view. 

- Show Statistics on Layer: presents a dialog box with the same statistics as 

presented in the Detail page, Value Info (see 5.5)  

- Classification: if one or more classifications are available for the data item 

shown as attribute layer, these are presented here. The user can select from the 

relevant classifications. 

 

Based on the type of layer some additional layer specific options are available: 

- Activate:  

- Theme: This option allows the user to select the data item in the tree that is 

visualized in the layer (e.g. to view relevant information of this item in the 

detail pages). The item and all it’s parents are shown as possible submenu 

options. The root item is presented at the bottom, the top menu options is 

the data item visualized in the layer. Activate a submenu option (or one of 

the other containers) to select the item in the tree. 

- Classification: This option allows the user to select the classes data item in 

the tree that is used to classify the data item for the visualization in the layer. 

The item and all it’s parents are shown as possible submenu options. The root 

item is presented at the bottom, the top menu options is the classes data 

item. Select this option (or one of the other containers) to select the item in 

the tree, e.g. for editing the classification with the classification and palette 

editor (see chapter 10). This editor can be activated from the selected classes 

item with the Ctrl Alt E keyboard combination.  

- Palette: This option allows the user to select the palette data item in the tree 

that is used to classify the data item for the visualization in the layer. The 

item and all it’s parents are shown as possible menu options. The root item is 

presented at the bottom, the top menu options is the palette data item. 

Select this option (or one of the other containers) to select the item in the 

tree, e.g. for editing the palette with the (classification and) palette editor 

(see chapter 10). This editor can be activated from the selected palette item 

with the Ctrl Alt E keyboard combination.  

- Select SubLayer(s), (not for grid layers); The different style aspects used to 

draw a layer can be activated separately. The style aspects differ for the different 

layers types. Therefore the set of submenu options differ per layer type. A  

indicates a style aspect is active (visible). For polygon and point layers, labels 

can be activated with the Select SubLayer >Label > Visible menu option.  

- Zoom 1 Grid to 1 Pixel (only for grid layers): The layer is zoomed to the 

level at which each grid cell corresponds with one pixel. This is often the most 

elegant level to present a grid. 

- Show Palette (only in case a palette item is used for visualization):  

This option toggles between showing and hiding the palette and label information 

in the legend of the classification scheme used for the data item. A  character 

before the menu option indicates the information is shown.  
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- Edit Palette 

This option activates the edit classification dialog (see chapter 10) to edit the 

classification/palette used to draw the layer. 

 

The pop up menu can also be activated by right mouse clicking in the map view. The 

layers visible in the map view are shown and the similar functions are available for 

these layers and for the general mapview/legend options.  
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Chapter 8: Datagrid 

8.1 Activating a Datagrid  

The Datagrid presents data items or a set of data items of the same domain unit in a 

Datagrid. All data items can be visualized in Datagrid. The Datagrid is the default 

view for items that can not be visualized in a geographic view, these items can be: 

- data items for which the domain unit cannot be geo referenced (parameters or 

other data items for which there is no geographic domain, like the label data item of 

a classification).These items are indicated by an  icon. 

- containers with data items as subitems (first level subitems). The first data item of 

this container determines the domain unit of the Datagrid, all data items that have 

this same common domain unit are visualized in the grid. These items are indicated 

by an  icon. 

   

As with the map view, a new Datagrid can be activated for a tree item, or the tree 

item can be added to an already opened Datagrid (if this opened view is of the same 

domain unit as the requested data item). The following table shows the possible 

actions to visualize a tree item in a Datagrid and the results of the actions: 

 
Action No active 

Datagrid for the 

requested 

domain unit 

Active Datagrid 

with same 

domain unit as 

requested data 

item 

Active Datagrid 

for another 

domain 

- Double click on 

selected tree item 

(only if the Datagrid 

is the default viewer, 

indicated by the  or 

 icon) 

New Datagrid 

window with the 

requested data 

item or all the 

subitems at the 

first level of the 

found domain.  

Data item or 

subitems at the 

first level with the 

same domain unit 

are added to the 

active grid.  

New Datagrid 

window with the 

requested data item 

or all the subitems 

at the first level of 

the found domain. 

- Enter key on 

selected tree item 

(only if the Datagrid 

is the default viewer, 

indicated by the  or 

 icon) 

New Datagrid 

window with the 

requested data 

item or all the 

subitems at the 

first level of the 

found domain. 

Data item or 

subitems at the 

first level with the 

same domain unit 

are added to the 

active grid. 

New Datagrid 

window with the 

requested data item 

or all the subitems 

at the first level of 

the found domain. 

- Main/pop-up menu 

option Default View 

(only if the Datagrid 

is the default viewer, 

indicated by the  or 

 icon) 

New Datagrid 

window with the 

requested data 

item or all the 

subitems at the 

first level of the 

found domain. 

Data item or 

subitems at the 

first level with the 

same domain unit 

are added to the 

active grid. 

New Datagrid 

window with the 

requested data item 

or all the subitems 

at the first level of 

the found domain. 

- Main/pop-up menu 

option Datagrid View  

New Datagrid 

window with the 

requested data 

item or all the 

subitems at the 

New Datagrid 

window with the 

requested data item 

or all the subitems 

at the first level of 

New Datagrid 

window with the 

requested data item 

or all the subitems 

at the first level of 
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first level of the 

found domain. 

the found domain. the found domain. 

- Ctrl-D on selected 

tree item 

New Datagrid 

window with the 

requested data 

item or all the 

subitems at the 

first level of the 

found domain. 

New Datagrid 

window with the 

requested data item 

or all the subitems 

at the first level of 

the found domain. 

New Datagrid 

window with the 

requested data item 

or all the subitems 

at the first level of 

the found domain. 

- Drag and drop to 

view area/active 

window 

On empty view 

area: New 

Datagrid window 

with the requested 

data item or all the 

subitems at the 

first level of the 

found domain 

Data item or 

subitems at the 

first level with the 

same domain unit 

are added to the 

active grid. 

Another view:  

Not allowed todrop 

the item. 

8.2 Datagrid 

Activating the Datagrid for the treeitem: /Brondata/buurt 

presents the following figure as example for the Datagrid: 

figure 8.1: Datagrid example for the tree item: /Brondata/buurt 

 

The mentioned tree item is an entity with thirteen elements. The subitems all have 

this entity buurt, configured as domain unit. Therefore all these subitems are shown 

in the table. 

The first column shows the id, and a label between brackets (as a label is configured 

for the domain unit), The other columns contain the data items requested. Most 

columns are colored grey, indicating their values can not be edited. Columns with 

values that can be edited are colored white. 

 

The width of the columns can be adapted by moving the mouse to the header row (in 

light grey background color with the labels of the presented data item), on the 

border between two columns. Click with the left mouse button, keep this button 

pressed and move the mouse to the left or the right to change the size of the 

columns. 

The sequence of columns can be adapted with drag and drop on the column header 

of a label. Click with left mouse button on a header, keep the mouse pressed and 

move the mouse to the requested position. 
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In the table a cell or a column can get the focus. Click on a cell or a column header 

to set the focus. Also a focus rectangle can be used to set the focus to multiple cells. 

Therefore first set the focus to one cell and use the arrow keys to enlarge the focus 

rectangle (colored black). Also in a focus rectangle, there is always one focus cell 

(colored blue).    

 

If the Detail page Value Info is active, the whole path of how this selected data value 

in the Datagrid is constructed is shown (see paragraph 5.6). The focus cell in the 

table is related to the information tool in the map view. If information is requested 

on a feature in the map view, the cell of the record of is this feature receives the 

focus and vice versa.  

 

A column receives the focus by a left mouse click on the label of the column in the 

header row. With a right mouse click on the label a pop-up menu for the column is 

actiavted, with four options: 

-     Sort on data item name: To sort values ascending or descending 

- Relative Display: to present the numeric values as percentage of the total 

-     Copy data item name: To copy the values of the item to a new data item with 

the name:  

- data item name + Copy + sequencenr, , mainly relevant in classifications 

- Remove data item name: to remove the selected column from the Datagrid. 

- Ramp Values: to ramp the values of a distribution, mainly relevant in 

classifications. This option is only available for not derived, numeric data items 

with more that one entry. 

8.3 tools 

If the Datagrid is active, the following tools are available in the toolbar: 

 

 

Copy visible area: Action to copy the visible contents of the active Datagrid to the 

clipboard. The table is copies as a picture. To copy the contents of the table as data, 

use the Copy text tool. 

 

  

 

Copy text: Action to copy the full contents of the table as text to the clipboard. A 

semicolon is used as separator between the different columns. String attributes are 

quoted. 

 

 

 

Show first selected row: Action to scroll the table to present the first selected 

row(s) in the visible part of the table. 

 

 

 

Select focus cell range: Select the records for which cells are part of the cell range 

in the table. The selection will also apply in the map view and vice versa. The 

selection color is light blue. 
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Select all: Action to select all rows in the table. The selection will also apply in map 

view. 

 

 

 

Select none: Action to deselect all rows in the table. The selection will also apply in 

map view. 

 

 

 

 

Show only selected records: Action to toggle between showing only the selected 

records or showing all records in the table.  
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Chapter 9: Histogram View 
 

9.1 Histogram view 

A histogram presents a graph with a frequency distribution of the occurring data 

values in a data item. If the data item is not classified (the value type of the values 

unit is not uint8), a classification is needed before a histogram can be made. Only 

the class values are used for the histogram view, not the palette colors or the labels. 

The following example shows the histogram for the data item: 

Analyses/AfstandOverWeg/apotheek/verzorgingsgebieden

 
figure 9.1: Histogram view for data item: 

/Analyses/AfstandOverWeg/apotheek/verzorgingsgebieden 

 
In the histogram the original data item: 

/Analyses/AfstandOverWeg/apotheek/verzorgingsgebieden is not classified.The X-as 

of the graph indicates the different services.The Y-as shows the count of the number 

of occurrences in the domain of the original data item, in this case woning, for each 

service area. The full name of the presented data item is shown in the graph title. 

 

A histogram can be activated with the main or pop-up menu Histogram View (Ctrl H) 

if the tree item is a numeric data item (not a parameter)  
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Chapter 10: Insert Classification and Palette  

10.1 Classifications and palettes 

Classifications are used to classify numeric data items into a set of classes. A 

classification is mainly used in primary data viewers to group relevant sets of 

elements. These groups are visualized using a same visualization style. In the 

GeoDmsGui 5.88 themes (colors, sizes, symbols and styles) are used to visualize 

classes of an attribute layer in a map view. The classification and palette editor can 

for the moment only be used to specify colors (other themes need to be configured 

in the dms configuration files, see the modeler’s reference). The set of colors for 

each class in a classification scheme is called a palette. Often also a label is 

requested for a class in classification that, if used, is shown in the legend of a 

primary data viewer.  

The next table shows where classifications in the GeoDmsGui 5.88 are used, 

depending on the requested data item: 

 
Data type Thematic map 

layer 

Histogram Export to 

bitmap 

    

Unclassified one 

dimensional numeric data 

item 

(value type int8, 

(u)int16/32, float32/64) 

Classification: obl 

Palette: obl 

Label: opt  

Classification: 

obl Palette: nu  

Label: nu 

Classification: 

obl Palette: obl 

Label: nu 

    

Classified one dimensional 

numeric data item and 

boolean 

(value type uint8 and 

boolean) 

Classification: opt 

Palette: obl 

Label: opt 

Classification: 

opt Palette: nu 

Label: nu 

Classification: 

opt Palette: obl 

Label: opt 

    

Non numeric data item 

(value type = string) 

Classification: np 

Palette: np 

Label: np 

Classification: 

np Palette: np 

Label: np 

Classification: 

np Palette: np 

Label: np 

    

Point, arc and polygon 

data (value types 

(s)(d)(f)(i) 

point/arc/polygon) 

Classification: np 

Palette: np 

Label: np 

Classification: 

np Palette: np 

Label: np 

Classification: 

np Palette: np 

Label: np 

obl: obligatory 

opt: optional 

nu: not used 

np: not possible  

  

Classifications and palettes in the Geo DMS can be configured for both data items as 

well as units. If a classification or palette is needed for the requested user action (as 

presented in the table), the GeoDmsGui first checks for the requested data item if 

these are available. If not, the GeoDmsGui checks for the values unit of the 

requested data item if a classification and palette is configured. In case no 
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classification and/or palette is found for both data item and values unit, a default 

classification is generated.  

 

Classifications including palettes and labels can be inserted or edited with the 

Insert/Edit Classification and Palette dialog. Select the data item or unit for which a 

classification needs to be configured and activate the Insert Classification and Palette 

main or pop-up menu option (or the Ctrl F keyboard combination). Use the Edit 

Classification and Palette main or pop-up menu option (or the Ctrl Alt C keyboard 

combination) to edit the classification and palette of a data item or unit. Be aware, if 

a data item has no classification configured, the Edit Classification and Palette option 

edits the classification configured for the values unit.      

 

10.2 Insert Classification and Palette dialog 

The editor can e.g. be activated from the legend in the map view. Activate a map 

view for the item: /Analyses/AfstandOverWeg/Supermarkt/afstanden. Activate the 

palette editor with the Edit Palette pop up menu option for this layer: The following 

view appears: 

 

 
fgure 10.1: PaletteEditor for /Analyses/AfstandOverWeg/Supermarkt/afstanden 

 

This view with the classification scheme contains a Datagrid, as described in chapter 

8. This Datagrid contains a color, label, classes and count column. The count column 

is grey, indicating it’s values can not be edited. The sequence of the columns and the 

width can be adapted as described in paragraph 8.2.  

 

Classes are always increasing and connected together. In the table the start value of 

each class is presented. The end value is the start value of the next classes, 

presented in the next row. The last class is always infinite. 

 

The pop up menu of the table view with some different options is available for the 

columns of the Datagrid. See the column description for their specific menu options. 

 

SymbolColor: individual colors can be edited by double clicking on a specific color 

cell. A Windows color dialog appears. The pop up menu option for this column 

contains the following options: 
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- Copy SymbolColor: to copy the color column to a new color data item, with the 

name of the original item, the extension Copy and a sequence number. This way 

color columns that can not be edited (e.g. because read from an odbc source) 

can be copied, the copy item can be edited.  

- Remove SymbolColor: to remove the column from the view 

- Ramp Colors: multiple color cells can be selected to ramp the colors. Select a 

start and end color for the ramp, and activate this menu option. The ramp can be 

made for all classes or a random selection of at least two consecutive classes. 

- Classify original data item: to classify the original data item, see the classes 

column. 

- Classes: to split and merge classes, see the classes column. 

- Copy Table m_4K: to copy the whole classification scheme. 

 

Label: individual labels can be edited by activating the cell and typing a new label or 

by pressing the F2 function key and editing the current label. The pop up menu 

option for this column contains the following options: 

 
 
- Copy m_4K Label: to copy the label column to a new color data item, with the 

name of the original item, the extension Copy and a sequence number. This way 

label columns that can not be edited (e.g. because read from an odbc source) 

can be copied, the copy item can be edited. 

- Remove m_4K Label: to remove the column from the view 

- Classify original data item: to classify the original data item, see the classes 

column. 

- Classes: to split and merge classes, see the classes column. 

- ReLabel: to relabel the contents of the label column with derived labels from the 

class boundaries 

- Copy Table m_4K: to copy the whole classification scheme. 

 

Classes: individual classes can be edited by activating the cell and typing a new 

class value or by pressing the F2 function key and editing the current class value. 

The pop up menu option for this column contains the following options: 
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- Relative Display: to present the values as % of the total  

- Copy Classes: to copy the classes column to a new color data item, with the 

name of the original item, the extension Copy and a sequence number. This way 

class columns that can not be edited (e.g. because read from an odbc source) 

can be copied, the copy item can be edited. 

- Remove Classes: to remove the column from the view 

- Ramp Values: with this option the class values can be ramped, like the colors. If 

the whole column is activated, this options functions likes the equal interval 

classification (see the next option) only based on the first and last value of the 

class breaks, where equal interval is based on the min and max value of the 

thematic attribute.   

- Classify original data item. This option is used to classify the classes. First 

specify the number of requested classes in the #classes text box. Next, select 

one of the four types of classifications that are available: 

- Unique values (available for all data items with a number of unique 

occurrences that fits in the range of the domain unit): a class is added for 

each value that occurs in the data item. The number of classes is based on 

the number of unique occurrences. The maximum number of classes is 

dependent on the domain unit of class unit.  

- Equal counts (available for all data items): the occurring data items are split 

up in classes with, as far as possible, an equal count of occurrences in each 

class. The class breaks are first set to the number of sorted data elements 

(excluding the nodata values) divided by the number of requested classes. 

Each class break is checked to determine whether the next data element has 

the same value as the data element at the break. If this is the case, the class 

break is increased to the next data element, until a data element is found 

with a new value. If this data element is not found before the next class 

break, the last class break is removed and the number of classes is decreased 

by one class 

- Equal intervals (available for all items): the range of the data in a data item, 

or the specified range of a values unit, is split up in intervals of the same size. 

If no range is specified the default range for the value type of the unit is 

used.  

- Logarithmic intervals (available for all items with a minimum value of zero): 

the range of the data in a data item or the specified range of a values unit is 

split up in intervals of the same size using a logarithmic distribution. If no 

range is specified the default range for the value type of the unit is used. 

- Classes. This option is used to split and merge classes. To merge, activate cells 

in the rows that need to be merged and activate this menu option. To split, 

activate a cell in the row that needs to be split and activate the split menu 

option. 

- Copy Table m_4K: to copy the whole classification scheme. 


